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I.  INTRODUCING WEB-BASED GIS SERVICES 

 

A GIS service, or Geoservice, provides a way to retrieve maps, images, or geoprocessing models or functions other 

people have published and likewise, allows you to share those you have created through the use of the World Wide Web.  

Internet users can then use the service in Web applications, mobile applications, or in the Environmental Systems 

Research Institute (ESRI) suite of applications.  There are many GIS services available; however, to maintain a 

reasonable scope for this course, we will be discussing the two most common services:  map services and image 

services.  The concepts presented here are intended to make users feel confident in using these two, as well as 

eventually other, Web-based GIS services.   

 

A map service, for instance, makes maps, features and attribute data available inside multiple client applications and thus, 

to a broader variety of clients.  One common use of a map service is to show business or internal engineering data on top 

of base map tiles from Bing Maps, Google Maps or ArcGIS Online (See the Glossary for definitions of terms that will be 

commonly referenced throughout this course.)  All ArcGIS web maps start with a base map.  Data layers are often added 

to it.  You might access a GIS service for pre-generated maps, for feature editing, for images or rasters, for network 

analysis functions, or for outside geodatabases.  For instance, if someone has published a network analysis service for 

roads in Tampa, Florida, a Field Engineer coordinating construction inspectors who run multiple inspections can access 

this service to find the most efficient route for visiting each project site.  This could be helpful if you do not have access to 

the roads data, or if you are not familiar with creating network analysis functions.  In another circumstance, you may be 

mapping utilities with a GPS-enabled device, such as a tablet.   A map service can provide a street or aerial base map to 

gain perspective on your location without the need for storing maps on your device, or when you are unsure of the extent 

of coverage you may need while in the field.   
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What is meant by pre-generated maps?  We are talking about map services capable of serving cashed versus dynamic 

maps.  Cached maps are those that use a set of previously created and tiled images at different scales and extents to 

allow the viewer faster access to different views of a map.  Google Maps, Bing Maps, ArcGIS Online and other services 

expose their maps this way.  Although users will just be viewing static pictures of your map, you can supplement a cached 

map service with find, identify, and query tasks to reach the underlying data.  Dynamic maps are drawn in real-time, thus 

providing access to the latest data changes, and to applications that require real-time display of data, such as weather 

updates.  The downside is that any changes to views of the map or geoprocessing each require requests to the server, 

and slow the regeneration of views or computations. Usage depends upon how the service was created.  If you would like 

to use an image or raster in an analysis, you would want to use an image service.  Image services also provide both 

cached (tiled) and dynamic access.  Both GIS services:  map services and image services, will be discussed in detail in 

this course.   

 

GIS-based services are made possible through the use of online GIS servers.  The services include resources such as 

maps, address locators, geodatabases, and tools that you might want to access or share.  As with any server technology, 

the advantage of sharing data over a server comes with the fact the data is centrally managed, supports multiple users, 

and provides the most current information.  You might ask:   “So why do I need a GIS server?  Wouldn’t any server work?”  

A GIS server is capable of not only sharing data, but providing access to the GIS functionality embedded in it.  In this 

course, we will mainly be discussing the ArcGIS for Server, ESRI’s replacement for ArcIMS.  ArcGIS for Server offers 

services for all of your GIS work, whether accessing, publishing, or securitizing it, and allows you to share GIS resources 

across an enterprise or across the Web.  It may be accessed through ArcGIS Online.  No specialized GIS software is 

required to work with a service.  It can be consumed within a web browser or within just about any GIS application.           

A map service, for example, allows various client applications access to the contents of a map on the ArcGIS for Server in 

much the same way they would if the map were stored locally.  Users need not be fluent in GIS to view and query maps, 

nor do infrequent GIS users need to be highly skilled in network analysis, geoprocessing models, image processing or any 

other GIS functionality to take advantage of them.   
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This course will be based on ESRI’s ArcGIS for Desktop products, and primarily on versions since the arrival of ArcGIS 

10.0, when ESRI made significant changes to their terminology, online servers and to the ArcGIS for Desktop interface.  

However, references to both version 9.x and ArcIMS topics will occasionally be made throughout the course for those it 

may benefit.  Furthermore, the following is a list defining the course scope, and assumptions made with regards to your 

knowledge entering this course.  It is recommended that you read it before purchasing this course.   

 

i. This course assumes the reader knows how to navigate the internet, or World Wide Web, and how to set up a basic login 

account.   

ii. This course assumes the reader is, at least, an infrequent user of ArcGIS for Desktop.  In particular, it assumes you are 

somewhat familiar with using ArcMap from the ArcGIS suite of applications (ArcMap, ArcExplorer, ArcScene, ArcGlobe, etc.).   

iii. A glossary has been provided for terms relevant to this course, but the user is expected to possess knowledge of basic GIS 

terminology.  On this note, the user is encouraged to take the SunCam course entitled “Introduction to GIS and GPS for 

Engineers and Surveyors” beforehand, if necessary.     

iv. This course is limited to working with data in 2D.  Three-dimensional services and packaging of 3D map layers may be 

referenced, but will not be discussed.  If you are experienced working with 3D data and would like to provide it as a service or 

package it for clients, then this course along with just a modest amount of additional training, can help you attain those goals. 

v. The reader is not expected to have prior experience with ArcIMS, ArcGIS for Server or ArcGIS Online.   
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vi. As noted in the Introduction, there are several GIS services that can be published.  These include, but are certainly not limited 

to feature, geocoding, and geoprocessing services. These services may be mentioned; however, due to the well-defined 

scope required for this course, we will limit detailed discussions to the more popular map and image services.   

vii. This course is intended for users with Windows operating systems.  It was not written for Linux, UNIX, or any Macintosh 

variants. 

viii. This course is intended for professional users of ESRI’s ArcGIS for Desktop applications.  While ESRI has GIS applications 

for Windows, iOS and Android mobile devices and operating systems, this course was written for the desktop user.  

References to mobile devices may be mentioned, where appropriate.     

ix. Sidebar information and links to websites are for your benefit and interest only.  No test questions will arise from this material.   

x. You do not need an ArcGIS license or ArcGIS Online account to take the test! 
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II.  ADDING SERVICES AND PACKAGES OFFERED    

    WITHIN ARCMAP  

 

ESRI offers multiple avenues to find background reference maps and packaged data online to get you started.   

Online sources are offered within ArcMap.  Thus, access to these maps and data require an internet connection.   

Adding built-in base maps 

ArcMap 10 includes several built-in maps from third party vendors that can provide quick, recognizable base maps for 

your work.  You add a base map to ArcMap (as well as ArcScene or ArcGlobe) through the Add Data, Add Base maps… 

command in the main menu.  This brings up a series of thumbnail images of different maps from which to choose.            

A description of the map is provided, and can be viewed as part of the layer properties.  You may also drill down to the 

layers to query data.   
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Adding maps and data from ArcGIS Online 

To add services to ArcMap from ArcGIS Online, click the Add Data drop-down menu to select the Add Data from ArcGIS 

Online… command.  This brings up a dialog box to search from the list of available layer packages and services shared 

online.  The packages may contain both maps and imagery.  A limited number of packages are available through ArcMap 

without an account.  Section IV on Working with GIS services in ArcMap introduces packages and discusses how to 

unpack the data.     
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III.  CONNECTING TO GIS SERVERS  

Connecting to ArcGIS for Server through ArcCatalog 

You can work with many types of GIS servers. The first step in every case is to establish a connection to the GIS server.  

One way is to connect using the Catalog window in ArcMap.  (For users new to ArcGIS 10.x, ArcCatalog can now be 

accessed inside ArcMap.)  This topic describes the steps for connecting to each type of GIS server.  Follow these steps to 

connect to ArcGIS for Server in ArcMap (or ArcScene or ArcGlobe): 

1. In the 

Catalog 

window, 

expand the GIS 

Servers node 

and double-

click Add 

ArcGIS for 

Server.  

 

2. A wizard 

asks if you want to Use ArcGIS services or 

Manage GIS Services.  Make your selection 

and click Next. 
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3. Enter the server URL address and, if needed, a user name and password.  

 

4. Click Finish to add a new ArcGIS for Server 

connection node in your GIS Servers folder.  
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Connecting to a Web Map Service (WMS) or  

Web Coverage Service (WCS) through ArcCatalog 

Web Map Services and Web Coverage Services (WMS or WCS) are acronyms coined by 

the Open Geospatial Consortium, Inc. (OGC) which represent a standard, or specification, 

for requesting and sharing spatially referenced maps and images dynamically over the Web. 

They are internationally recognized standards that allow for GIS services to be accessed 

across broad platforms and many clients.  Some organizations require their geographic data 

and maps to be available in this specification.  Whether connecting to a WMS or WCS, the 

steps are the same.   

Here are the steps to connect to WMS and 

WCS servers in ArcMap, ArcScene, or 

ArcGlobe: 

1. In the Catalog window, expand the 

GIS Servers node and double-click 

Add WMS Server or Add WCS 

Server.  

 

 

 

About The Open Geospatial 
Consortium 
 
The Open Geospatial Consortium 

(OGC) is an international industry 

consortium comprising hundreds 

of companies, government 

agencies and universities 

participating in a consensus 

process to develop publicly 

available interface standards.  

They worked with the 

International Standards 

Organization (ISO), to produce 

the Web Map Service (WMS) 

Implementation Specification, or 

ISO 19128. 

   

The ISO is an international 

standard-setting body composed 

of representatives from national 

standards bodies that produce 

world-wide industrial and 

commercial standards.  ISO 

standards are voluntary, but some 

agencies enforce their use in 

specific areas. 

 

http://www.suncam.com/


 
GIS – Beyond the Basics:  Web Maps & File Sharing Services 

A SunCam online continuing education course 

 

 
www.SunCam.com  Copyright 2015 Julie Coco Page 11 of 78 

 

2. The Add WMS Server or Add WCS Server dialog box 

appears. Type the server URL and other properties for 

your connection.  Click Get Layers to view the service 

layers.    

 

3. The WMS or WCS server connection is added as an item in 

your GIS Servers tree view.  Click OK to initiate a connection 

within ArcMap.  You can expand and work with the services 

provided by this connection. 

 

 

You would connect to an ArcIMS Server in a similar manner as that 

described here.  ArcIMS is ESRI’s legacy internet map and image 

server.  ArcGIS 10.0 provided the last release of ArcIMS.   

 

Once connected to ArcGIS for Server, a WMS or WCS server, or an 

ArcIMS server, simply click the service from within ArcCatalog and 

drag it onto your map document.   
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Connecting to GIS servers through the ArcMap Toolbar 

Connections to GIS servers can be also made through the Add Data menu button within ArcMap.  Below are instructions 

for connecting to servers, and then adding one or more of their services.   

1. Click the Add Data button  on the Standard toolbar to open the Add Data dialog box. 

 

 
 

2. Click the Look in arrow from the drop-down menu and choose GIS Servers. This gives you a list of servers.  

Two such servers are listed here. 
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3. Double-click the server you want to access. This establishes the connection to the server.                               

Choose the service(s) you want to add to your map from the options below: 

 

ArcGIS for Server map services are shown in the Add Data dialog box with this icon:   

Select the map service you want to add.   

 

ArcGIS for Server image services are shown in the Add Data dialog box with this icon:    

Select the image service you want to add.   

WMS services are shown in the Add Data dialog box with this icon:  

Choose the service you want to add, or double-click to access an individual service sublayer.                      

You may also select groups of sublayers.   

 

 

WCS services are also available.  Click the desired WCS server to open the list of WCS layers.  Each layer 

appears in the Add Data dialog box with this icon:    Choose one or more service layers from the list.   

 

Tip:  When you add individual WMS sublayers, you create one WMS service entry in the 
table of contents for each sublayer you add.  Additional service layers require additional 
requests to the server, and may affect performance.  To minimize these requests, you 

may want to add an entire WMS layer and use the Layers tab of the Properties dialog box 
to turn the display off for certain sublayers.  Layer properties will be discussed in Section 

IV – Working with GIS services in ArcMap. 

http://www.suncam.com/


 
GIS – Beyond the Basics:  Web Maps & File Sharing Services 

A SunCam online continuing education course 

 

 
www.SunCam.com  Copyright 2015 Julie Coco Page 14 of 78 

 

ArcIMS image services (map services) are shown in the Add Data dialog box 

with this icon:   An image service is a composite of any number of sublayers.  

Individual sublayers are not accessible. You cannot add them separately from 

the entire map service. 

 

ArcIMS feature services are shown in the Add Data dialog box with this icon:   

Choose the feature service you want to add, or double-click to access an 

individual feature service sublayer (feature class).  You may also select groups 

of sublayers. 

 

4. Click Add.  The service is added as a layer(s) within ArcMap.  

 

If you don't see the server you want in the Add Data dialog box using the method above to 

connect, you can double-click Add…Server to connect to the appropriate server.                 

This action yields the same method and result as connecting through ArcCatalog. 

  

Tip:  If you closed out of an ArcMap document from which you previously connected to a 
GIS server and then re-opened the document, your connection will still appear in 

ArcCatalog (unless of course, you disconnected it), but you may need to reconnect or 
occasionally, reset the data source.  To do this, simply right-click on the server in 

ArcCatalog to access the content menu for this, as well as other commands. 

About Feature Services 
 
Feature services are also 

available from the ArcGIS for 

Server and from an OGC Web 

Feature Service (WFS).               

A feature service provides access 

to data in a geodatabase stored 

on an online GIS server.     The 

server must have permission to 

access a feature service 

geodatabase for querying or 

performing edits that can be 

applied to the server.  

Additionally, you need the ArcGIS 

for Desktop Standard or higher 

license to use it for web editing 

(can only query & publish with 

Basic).  Finally, you need a 

license to obtain a Data 

Interoperability Extension used to 

convert between geodatabase 

and non-native data formats 

when importing or exporting data, 

such as when accessing WFS 

datasets in ArcGIS.  Feature 

services are not discussed in 

detail in this course, due to the 

level of involvement required to 

access and edit them.  If you are 

comfortable working with map 

services, you will be able to 

decide whether online feature 

services are needed for your 

project.       
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  IV.  WORKING WITH GIS SERVICES IN ARCMAP 
 

Layer Packages and Map Packages   
 

Layer Packages, not to be confused with Layer Files (See the SunCam course “Introduction to GIS and GPS for 

Engineers and Surveyors”.), contain the actual data and preserve the symbology and labels of the layers in which you 

were working.  In other words, it combines a layer file and the data, or data source it references, with one tool.  This is in 

contrast to the traditional method of viewing another ArcGIS map, whereby you must download the shapefile(s) or 

geodatabase and layer file, in addition to the map document (*.mxd) file in order to reconstruct the map.  With Layer 

Packages, your users need not worry about access to the data.  Layer packages were introduced with ArcGIS 9.3.1.   

 

Map packages became available with the introduction of ArcGIS 10.0.  They include not only the data, symbology and 

labels of the layers, but also the MXD file.  With a Map Package, you no longer need to worry about opening an ArcMap 

document with broken links.  When MPK files are extracted, or unpacked, the MXD and all referenced data as well as 

properties are included such that a recipient sees your map exactly as you had created it.  A Map Package is a snapshot 

of your map and the current state of its data.  These steps show how to extract packages from various locations.   

 

Extracting local Layer Packages (*.lpk) and Map Packages (*.mpk): 

 

1. In the Catalog window of a new ArcMap document, connect to the folder on your hard drive, removable drive or 

local server where the file is located, if necessary.  Navigate to the location of the *.lpk or *.mpk file.   

 

2. Right-click the file and select Unpack from the context menu.  The layers will appear in the table of contents of 

your ArcMap document.  For a map package, the layout view will also provide a map.   
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Alternatively, you can unpack a package from within ArcCatalog.  ArcMap will be started automatically.  Packages 

can be unpacked into new or existing folders, but are unpacked into Microsoft Windows user profiles by default.  

The extracted path is as follows: 

 

Vista, 7, or 8.x OS    C:\Users\<username>\Documents\ArcGIS\Packages 

XP OS   C:\Documents and Settings\<username>\My Documents\ArcGIS\Packages 

 

 

 

Extracting Layer Packages, Web Maps, and other services from ArcGIS Online: 

 

1. Open ArcMap and select File > ArcGIS Online… to browse data from the pop-up dialog box that follows.  If you 

have an ArcGIS Online account, you can sign in to ArcGIS Online through File > Sign In… or through the pop-up 

dialog box to allow you to view additional non-public maps that others have published.   

 

 

Tips:  Only unpack a layer package from within Windows Explorer when ArcMap is closed or opened 
as a new file.   Double-clicking or dragging and dropping to open or unpack a layer package while an 
existing ArcMap document is open will dump the package layers into the table of contents with any 

existing layers.  The same applies if you are unpacking from within the Catalog Window. 
 

Double-clicking to unpack a map package from within Windows Explorer when an existing ArcMap 
document is already open will prompt you to save the *.mxd file before closing it and opening the map 

package.  The same applies if you are unpacking from within the Catalog Window. 
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2. Search and select the appropriate subject for your document.  Click Add or Open to add layer packages, feature 

services and image services, or to open web maps.  Clicking Details allows you to view basic metadata.  

Remember that layer packages include downloading actual data, and can result in very large *.lpk files!   
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Alternatively, you can use the geoprocessing tools in ArcToolbox through Data Management Tools > Package to assist 

in the above processes while in your ArcMap document.  These tools consolidate, package, extract and share documents 

and layers.  They provide more options for packaging.  See the ESRI’s Online Help topics for individual tool descriptions.   

 

 
 

The Package Tool as shown from within ArcToolbox 

 

Using ArcGIS for Server map service layers 

A map service, as described here, includes a map someone created in ArcMap and published to the ArcGIS for Server.  

The basic map service provides the user with images of a map and certain attribute information of features. Depending 

upon how the service was authored, you may find map services with access to:  vector features for editing, KML features 

for use in geobrowsers such as ArcGIS Explorer and Google Earth, network analysis functions, OGC compliant services 

such as WMS and WCS, and mobile data, among still other capabilities.  If you have ever used map service layers from 

ArcIMS, ESRI’s legacy online GIS server, then you should find using ArcGIS for Server map service layers to be similar.   
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Viewing ArcGIS for Server map service layers within the Table of Contents 

Once you’ve established a connection to a GIS server and added a map service to 

an ArcMap document, you will see one new composite layer, composed of 

sublayers. The map service group layer (“PLSS”) is initially contracted in the table 

of contents shown here. Click the plus symbol   to expand the service layer to 

see its sublayers and legend information. 

 

Note the line connecting the sublayers together. This line prohibits you from 

inserting a layer within this service (group) layer or breaking apart the service layer 

into its constituent sublayers.  In other words, you cannot add or remove sublayers 

in the map service.   

 

 

 

 

 

 

 

 

A map service layer as shown in an ArcMap document table of contents 
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Finding the properties of an ArcGIS for Server map service layer  

 

Right-click the service group layer and 

select Properties to view the Layer 

Properties dialog box. The Source tab 

displays information such as the map 

extent, data (service) type, URL of the 

server, and the coordinate system of the 

service.  It may also display the type of 

operations allowed.   

 

 

The Layer Properties dialog box for each 

sublayer typically includes only the 

General tab, which provides a description 

of the sublayer along with the scale range 

available for viewing. 

 

 

 

Layer Properties dialog box for an ArcGIS for Server map service 
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Changing the display of an ArcGIS for Server map service layer 

 

There are a number of things you can do to affect the display of a web map layer.  You can toggle layer or label visibility 

on and off, set a background color for the service, and apply transparency.  You cannot however, reorder the sublayers in 

a map service published using ArcGIS for Server.   

 

You can also turn the visibility of map service 

sublayers on and off using the check boxes in the table 

of contents. You can also toggle the visibility of 

sublayer labels by right-clicking the sublayer in the 

table of contents and selecting Show Labels from the 

shortcut menu.  Note that when you are working with 

map and image services published using ArcGIS for 

Server, symbology cannot be changed. 

 

 

 

 

 

 

Sublayer properties of an ArcGIS for Server map service 

Sublayers of the PLSS service layer 
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Querying features from an ArcGIS for Server map service layer 

A basic map service includes the ability to identify and query certain 

feature attributes. ArcMap displays what is returned by the server inside an 

Internet Explorer control embedded in the Identify window. The result of an 

Identify query may be provided as field/value pairs, HTML, or images. 

When you query a map service sublayer, you will see not only feature 

attributes, but also options for viewing attributes from just the sublayers of 

interest.  This graphic shows a typical example of the view from an Identify 

dialog box of an ArcGIS for Server query.  

In this case, we have chosen the “Townships” sublayer from which to view 
attributes.  By clicking on your area of interest with this layer turned on, we 
can identify its township and range, as well as a few other attributes.     

The release of ArcGIS for Server 10 introduced feature service capabilities 

for map services.  This capability exposes access to vector feature 

geometries and attributes.  A benefit of feature services is the ability to 

enable feature editing through web scripts (e.g., Silverlight, Flex, and 

JavaScript).  Feature services are published from map documents, and the 

source datasets are required to reside in a single ArcSDE geodatabase.  

     

The Identify window displays attributes from a map service query inside ArcMap 
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Using ArcGIS for Server image service layers   

An image service provides access to raster data through a web service.  Image services published through ArcGIS for 

Server provide access to the contents of a raster dataset or mosaic dataset, including its properties, pixel values, color 

bands, spatial reference and extent.  (Refer to the Glossary for a definition of Mosaic Datasets.)  Image services are good 

for publishing or accessing large collections of raster data, such as a Digital Elevation Model (DEM).  LiDAR, or LAS 

datasets, are an example of a raster dataset that can be shared as an image service.  Depending upon the specifications 

by which the author publishes the service, source files containing the data of image service layers can be used to conduct 

spatial analyses or make 3D measurements.   

 

Viewing ArcGIS for Server image service layers within the Table of Contents 

Image service layers are simply viewed in the ArcMap table of contents with the service name and each of their composite 

RGB color bands.  When your image service is composed of multiple images, you can select one or more images and add 

each one as a single layer in the table of contents.  This allows you to view only the image(s) or extent you want rather 

than the entire contents of the image service.  You can achieve this by right-clicking on the raster dataset in the table of 

contents and selecting Data > Export Data.  When in ArcMap, click on the underlined blue text:  “About export raster 

data” as shown in the figure below to help you select export options.   
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Export options for an ArcGIS for Server Image Service 
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Finding the properties of an ArcGIS for Server image service layer and changing its display    

An image service layer has properties 

similar to other layers in ArcGIS.  

Right-click the layer and select 

Properties to view the Properties 

dialog box for an image service layer.  

The General and Source tabs are 

similar to that of the map service 

described earlier.  Like a raster 

dataset layer, the Layer Properties 

dialog box contains the General, 

Source, Extent, Display, and 

Symbology tabs.  However, the 

Display tab for an image service 

layer has a couple of additional 

options.  A check box is included to 

allow interactive control of brightness, 

contrast, and transparency of a layer 

when using the Effects toolbar.   

If unchecked, the layer will only be 

updated when you are finished with 

the toolbar.   

 

Display options for an ArcGIS for Server Image Service 
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A check box is also included to display the service resolution in the table of contents.  The service resolution is the ratio of 

screen pixels to image cells at the current map scale.  It helps determine how close you are to displaying the maximum 

resolution of the raster.  A drop-down menu box is included for ways to resample your raster for view after panning or 

zooming.  A drop-down menu and text box are also included to specify the compression applied to transmitted data.  This 

transmission compression is usually preset on the server side of an image service, but can be changed by the user.          

A highly compressed image transmits faster than an uncompressed image; however, image quality is typically sacrificed.   

ArcGIS for Server image services allow users to further enhance an image by changing the (color) band combination or 

stretching the histogram.  These options fall under the Symbology tab.  These enhancements are beyond the scope of a 

typical engineer’s responsibilities, and will not be discussed further.  You can visit ESRI’s ArcGIS Resource Center (See 

Glossary) for assistance on this topic. 

If your image service was created from mosaic datasets (as opposed to a single raster dataset), the Properties dialog box 

will show additional tabs corresponding to the functionality needed to work with these datasets. 

 

Querying the attributes of an ArcGIS for Server image service layer  

There are many ways to query image service layers for information.  You can use the Identify  tool on the Tools 

toolbar to query the raster values in an image service layer to get raw and rendered pixel values.  This tool can also allow 

you to identify raster datasets that exist at your scale.   

 

The use of common tools such as Select by Location, Select by Attributes, or Select by Graphics from the Selection 

menu or tools from the Tools toolbar, such as Select Features By Rectangle may be used for queries.  You can also 

open the attribute table inside ArcMap to select one or more rows. 
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Selected raster attributes from an image service layer shown in an attribute table, while results from use of the Identify tool in the same area 

provide pixel values as shown in the dialog box. 
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Queries based upon attributes of raster datasets can also be made from the Definition Query tab of the Layer Properties 

dialog box.  For example, you may wish to inquire that only data within a specific time period are displayed, if offered by 

the service. 

If you are interested in obtaining discrete raster data (those with attributes), you can download the source files of your 

image service or mosaic dataset according to the following steps and options: 

 

1. Make a selection using one of the above mentioned tools or methods. 

 

2. Choose either to create a single layer with an extent specified by the selection set, or add each image as a 

separate layer to the table of contents via the following options: 

 

 To clip the layer extent to the selection, right-click the image service layer and click Selection > Create Layer 

From Selected Features. 

 To add each selected image to the table of contents, right-click the image service layer, click Selection > Add 

Selected Rasters To Map…, enter a group layer name and choose a field in the attribute table that will be used 

to name each layer, then click OK. 

 

Tip:  If you only see the footprints of the raster datasets but not the actual raster data, it 
may be because the rasters cannot be viewed at the scale of your display. You can zoom 

in or right-click the layer and click Zoom To Service Resolution. 
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Source files may include raster datasets, LAS files or LAS datasets, and are accompanied by their metadata and/or 

projection files.   

 

You may also wish to download selected rasters from an image service to a local disk, if the service allows it.  If so, 

complete Step 1, then right-click the image service layer in the table of contents; point to Data, then click Download 

Selected Rasters.  From the dialog box that opens, specify a location on your disk where the rasters will be downloaded.  

Check the item(s) in the Downloaded Files List to download raster datasets.  Once downloaded, you can click Add to 

Map to add the downloaded data to your ArcMap document.  Source rasters can be clipped before downloading.     

 

Note:  Source files stored using the GRID raster format or terrain dataset cannot be downloaded.   

 

 

Using WMS Layers  

Web Mapping Service (WMS) services can be used in ArcMap (as well as in ArcScene and ArcGlobe) as map layers.  

Every WMS, by definition, provides metadata about its service and access to its map.  Depending upon how the service is 

configured, a WMS may also provide information about its features within the map.  The following are some common 

tasks for working with WMS layers. 
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Viewing WMS layers within the Table of Contents 

Once added to ArcMap, the WMS service layer's entry in the table of contents can be expanded to see the individual 

layers it contains.  A WMS service layer is made up of three entries that are arranged hierarchically in the table of 

contents. At the top is the name of the WMS service, which holds all the WMS map layers. The next level is WMS group 

layers, whose only function is to organize WMS sublayers into related groups. There is at least one WMS group layer (and 

potentially nested groups). WMS group layers do not hold any map layers; it is the third group, WMS sublayers, that 

actually contains the map layers. 

 

Note the line connecting the sublayers together. This line prohibits you 

from inserting a layer within this service (group) layer or breaking apart 

the service layer into its constituent sublayers.  Manipulating WMS 

sublayers will be discussed shortly. 

 

 

Viewing WMS Legend Information  

When a WMS service includes legend information, you can view the WMS sublayer's symbology in the table of contents 

by clicking the expansion control next to a sublayer.  Some WMS services do not include legend information about the 

symbols used by the layers in the service.  Legend support is optional when publishing a map service using OGC WMS 

specifications.  When legend information is not available, no symbology is shown for the layers in the table of contents.  
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These layers will be listed in the table of contents without expansion controls next to them.  Since accessing a legend for 

each layer in a WMS service requires sending a separate request to the server, the legends for the layers in WMS 

services are all hidden by default.  (Web map services published using ArcGIS for Server with the OGC WMS 

specification are enabled by default to provide legend information.) 

 

Finding the properties of a WMS layer 

Similar to other layers in ArcMap, a service layer 

provides properties under the General and Source 

tabs in the Layer Properties dialog box.  Right-click on 

the layer to access this box.  It displays information 

such as the map extent, data (service) type, the URL 

address, service name, and the default coordinate 

system of the service.  

The Layers tab displays all the members of the WMS 

service. Information provided by the WMS server for 

each WMS layer is displayed in a box on the lower left 

of the dialog box. 

 

Sublayer properties of an OGC Web Map Service 

Service and sublayer information taken 

from the WMS service capabilities file 

 

Listing of all sublayers 
available from the WMS 

service 
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Changing the display of a WMS layer 

There are a number of things you can do to affect the 

display of a WMS layer. These include changing the 

feature symbology, toggling layer or label visibility, 

changing the drawing order of service sublayers, 

setting a background (basemap) for the service, 

applying transparency, and (if supported by the 

server) visualizing the service based on a time 

parameter. 

Depending on how the WMS service is authored, you 

may be able to change the rendering of a WMS layer. 

WMS layer rendering is determined by a style. The 

style consists of the symbols and colors used to 

represent features in a WMS service. The WMS 

specification allows a WMS layer to contain any 

number of styles. You can choose from the available 

styles using the Styles tab of the WMS service 

sublayer's Layer Properties dialog box. 

Feature rendering options for an OGC Web Map Service 

 

Legend information 

 

Legend preview 

 

Choose a style 
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If the WMS service does not support styles, you will see “Legend not available” in the 

preview window. As you choose different styles from the drop-down menu, the information 

in the text box and the image in the preview window changes accordingly. You can preview 

as many of the listed styles as you want. The style is not applied to the layer until you click 

OK or Apply, and a new request sent to the server.   

This tab also includes information describing the given style, the height and width of the 

legend image in pixels, the URL for the legend image, and the image format. 

When you add a WMS service into ArcMap, all the layers in that service are available for 

display in the map, even if you only add a single WMS sublayer or a single WMS group 

layer.  Even though the table of contents entry for the service layer only lists the added 

sublayer, you still have access to the entire list of sublayers through the Layer Properties 

dialog box of the service layer.  In cases where you add an entire WMS service, the table of 

contents entry for the service layer will include all the layers and groups, using the drawing 

order defined by the author of the service.  Some WMS services contain a large number of 

layers and are more like data collections than individual maps. 

The Layers tab allows you to choose which WMS service sublayers to display in your map.  

 

 

A Bit about WMS Legends   
 
The size of WMS legends can 

vary quite a bit.  Occasionally, the 

size of the legend specified by the 

server is too large to be displayed 

in the ArcMap table of contents. 

This usually happens when the 

legend for a layer contains 

multiple symbols, such as a 

transportation layer displaying 

symbology for the different types 

of roads. With WMS services, the 

legends for sublayers are 

transmitted over the Web as one 

image containing all symbols and 

text labels.  Although ArcMap 

supports legend entries with 

multiple symbols in its table of 

contents, it expects these entries 

to contain multiple images, one 

image per symbol.  ArcMap also 

places a limit on the size, height, 

and width (in pixels) of an image it 

will display in the table of 

contents. When the image 

received for a layer in a WMS 

service exceeds this limit, no 

legend is displayed for the layer. 

These layers are therefore listed 

in the table of contents without 

symbology and without expansion 

controls. You can still view the 

legend in the Layer Properties 

dialog box.   
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Sublayers within an OGC WMS group layer can be displayed independently within the  
ArcMap table of contents 

Choose which sublayers will be 

visible in the table of contents 

from the buttons below 

 Reorder 

sublayers 

 

Turn 

sublayers 

on or off 

 

A Bit about WMS Legends, 
continued 
 
If you wish to display the legend 

in the page layout, you can use 

the sublayer context menu 

command, Add WMS Legend to 

Map. This command will add the 

legend as a graphic to the map. 

Note that you can only add a 

single WMS sublayer legend at 

one time.  
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On the left side of this dialog box, you will see all the WMS group layers and WMS sublayers for the service listed.  The 

arrangement of those items can only be changed by the author of the service.  If you had only added select sublayer(s), 

and now want to include all of the layers in your ArcMap table of contents, then select the All Layers radio button under 

this tab.  However, selecting Just the layers listed below on the right side of the box allows you to configure which 

layers in the WMS service will be included in table of contents entry, allows you to add and remove specific WMS layers 

from your map, and allows you to control layer visibility and drawing order.  Note that when you use the Just the layers 

listed below option, any groups into which the layers have been organized by the publisher of the service will not be 

reflected in the table of contents. The layers you choose will appear in an ungrouped list in the table of contents, the same 

as they appear on the right side of the dialog box. When you apply the changes or hit OK, you will see the updates in the 

table of contents, and the new drawing order will be reflected in your map.  ArcMap sends a new request to the WMS 

server to account for the new drawing order. 

 

Changing other WMS layer properties  

There are a few properties you can change for a service layer, such as changing its name, changing the description, and 

setting visibility scale ranges or the image format returned by the server. 

You can change the name the service layer either by clicking the service layer in the table of contents and typing a new 

name, or by opening the General tab of the Layer Properties dialog box (as with any non-service ArcMap layer) and 

entering a new name there.  The Description text box is initially populated with an abstract, when one is provided by the 

service. You can change the description for WMS service layers, but the Description text box for group and WMS 

sublayers within the WMS service are read-only.  
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You can set visible scale ranges on the service layer where all the sublayers contained within it only draw when the map 

is within specified scale range. By setting a scale range on a service layer, you can avoid sending image requests to the 

server at map scales that are inappropriate for the layer's data. You set scale ranges on the General tab on the Layer 

Properties dialog box. Scale ranges can only be set at the service level for map services. You cannot set them for service 

sublayers.  Bear in mind too, that reporting the scale range is optional under the OGC WMS specification.  Thus, this 

information may not appear under the General tab, even if the sublayer draws within the correct scale range.  ArcMap 

cannot determine scale ranges for WMS layers; it can only provide the information given to it by the WMS service. 

 

Querying features from a WMS layer 

Identifying features is the only querying task you can perform on WMS layers, although the format of information you 

receive can vary depending on the server. ArcMap displays what is returned by the server inside an Internet Explorer 

control embedded in the Identify window. The result of an Identify query may be provided as field/value pairs, HTML, or 

images. 

By the OGC WMS specification, WMS services are not required to provide querying services for features.  If the service 

supports identification, like the one in the graphic below, you will see its sublayers listed in the Identify window. If you don't 

see them listed, you won't be able to identify features from that WMS service. 
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Results from an Identify query of a WMS Feature 

 

Because there is no concept of a primary display field for a feature identified in a WMS service layer, the node in the 

Identify tree representing the features in a WMS service layer is always referred to as WMS Feature(s). 

When you identify a feature from a WMS service layer, you should either use the <Visible Layers> option, to identify 

features in any of the visible layers, or choose the particular layer you are interested in identifying. This is because the 

default option, <Top-most layer>, may not work as you expect.  
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When you use this option and click the map, Identify will only work on features from the 

topmost layer in the WMS service's drawing hierarchy. If there are no features present in the 

layer at that location, this option does not automatically identify features from layers lower in 

the drawing hierarchy as it does with other layer types, such as those referencing shapefiles 

or geodatabase feature classes. Instead, you'll receive null results. This is a limitation of 

WMS servers. 

In addition, Identify tolerance levels are determined by the WMS server, not ArcMap. When 

identifying WMS point features, you may have to repeat your clicks until you get close 

enough to the feature to register a positive result. 

 

Displaying a WMS layer in different coordinate system 

Like with other layers, if a WMS service layer is the first layer added to a new data frame, 

the data frame will take on the default coordinate system of the WMS. 

When using WMS services, you may want to keep to server-supported coordinate systems 

for best results. WMS servers may only support a limited set of coordinate systems, 

depending on how the service has been configured by its author.  In addition, each WMS 

sublayer within the WMS service can potentially support a different set of coordinate 

systems.  If the data frame is in a coordinate system that is not supported by the WMS 

server, ArcMap gets an image from the server in a supported coordinate system (in most 

cases, this will be in GCS 1984/WGS84) used with OGC servers 

Handling WMS server errors 
 
You may sometimes get an error 

message from particular WMS 

services when you add them into 

a map.  As with any live Web 

mapping service based on 

images, when ArcMap attempts to 

draw a service in a map, it sends 

a request for an image to the 

WMS server providing that 

service.  If the server returns an 

error instead of an image, ArcMap 

will display that error message. 

These error messages, which 

appear each time you redraw the 

map, reflect problems with the 

WMS service and normally can't 

be remedied in ArcMap.  ArcMap 

displays these messages to warn 

you that something about the 

WMS service is not working as 

ArcMap expects, and to provide a 

basic diagnostic capability.  

However, because these errors 

can vary widely between different 

WMS servers, it is difficult for 

ArcMap to tell you the exact 

problem.  As a result, the error 

messages are fairly generic, and 

what the problem is may not be 

obvious.  For example, the error 

may be caused by a particular 

layer belonging to the WMS 

service or to a particular 

combination of layers. 
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and projects this image internally so it will display in your map.  In other words, ArcMap will 

re-project this image “on the fly”.  In this situation, there could be some distortion in the 

display of the WMS layer, and may be most noticeable if the layer has text.  

 

Using WCS Layers  

An Open Geospatial Consortium, Inc. Web Coverage Service (WCS) provides an open 

specification for sharing raster datasets through the Web.  This web service returns data in 

a format that can be used as inputs for analyses and modeling.  This differs from the OGC 

WMS services, which only return an image of the data.  The raster datasets made available 

through WCS services are referred to as coverages. These should not be confused with the 

vector datasets available in previous versions of ArcGIS, which were also called coverages.  

(See the SunCam course “Introduction to GIS and GPS for Engineers and Surveyors” for a 

detailed explanation of vector coverages.)  WCS services are comprised of raster images, 

single raster datasets or mosaic datasets.  Yet, this is a very robust service providing not 

only image, but also map, and even geodata service capabilities.  Like raster layer 

properties, the Layer Properties dialog box for a WCS service layer has five tabs: General, 

Source, Extent, Display, and Symbology. Unlike a raster layer, a WCS layer doesn't have 

statistics, discrete color maps, or a raster attribute table.  You can query raster cells for their 

attributes in the same manner as mentioned above for a WMS.  Feature attributes, when 

available, are queried much like any other GIS vector layer.  Additionally, a service with 

WCS capabilities allows users to change band combinations or stretch histograms of 

images to enhance their appearance.   This capability is shared with that of an ArcGIS for 

Server Image Service, but not with the OGC WMS.   

 

Handling WMS server errors, 
cont.  
 
If you get an error message, you 

can stop it from appearing again 

by simply unchecking the WMS 

service in the table of contents or 

removing it from your map.  

Sometimes, you may be able to 

tell which layer in the WMS 

service is causing the problem.   

In that case, try turning off that 

particular layer in the table of 

contents.   

 

Note that if you get an error 

message from a WMS service, it 

doesn't necessarily mean that you 

won't be able to draw this service 

in your map at all. For example, 

some WMS services may return 

the error "Bounding box has an 

invalid area" when you try to draw 

them at a very small scale, but 

the service will draw, and the 

error message won't appear when 

you zoom in to larger scales.  In 

this situation, you should specify 

a scale range for the WMS 

service layer using the General 

tab of its Layer Properties dialog 

box so the layer is not drawn at 

very small scales. This will 

prevent the error messages from 

appearing when the layer can't be 

drawn. 
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V.  PRINTING AND EXPORTING MAPS CONTAINING SERVICE LAYERS 

You can print and export maps containing service layers.  However, you need to be aware of limitations that are inherent 

with working with image-based services.  Servers generally maximize performance by specifying a size limit on all output 

images they create.  This size limit is set by each server and can vary from service to service, but limits are primarily set 

for optimum display on a computer monitor.  The average screen resolution is typically 96 dots per inch (dpi).  When you 

add an image-based service to a data frame in the layout view of ArcMap, it sends a request to the server for the 

appropriate number of pixels to fit the data frame.  In this setting, the image size should be below the limit of the server. 

Thus, it is important to remember that when you print or export a map with an image service, you are working with a 

raster.  When you want to print the same image to a printer with a dpi of 600, ArcMap can set the dpi to 600, and an 

image request is made to the server.  For example, if your data frame is 7 inches by 10 inches and you specify a map of 

600 dpi quality, ArcMap sends a request to the server for an image of (7 x 600 = 4,200) x 6,000 dpi equal to 25,200,000 

total pixels.  If the requested image file size exceeds the limit set by that server (as it may here due to the increased 

number of pixels requested), the layer will either be stretched or not drawn at all, depending on the type of service.  If 

ArcMap makes a request that is larger than the limit, the server will send the largest image it can.  ArcMap will then 

stretch the image to fit the data frame.  This will decrease the image quality.  In this example, you may be able to view the 

image in the data frame with good clarity, but it may not be suitable for printing.  Some WMS servers do not state an 

output image size limit.  When the request is sent to the server, there may not be an error message reporting this limit.  

With no limit reported, ArcMap cannot choose an arbitrary size, so you will need to experiment to determine the proper 

image size for printing or exporting.  Size limits for service layers can only be changed by the server administrator.  

Cached web map layer images are sized with the intent to be viewed only on a screen.  For the average ArcGIS (or 

ArcIMS) map service, you should be able to print a decent quality letter-sized map.   
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Maps can be exported to several industry-standard file formats.  Formats for exporting vector data include Windows 

Enhanced Metafile, Adobe Illustrator, and Portable Document Format (EMF, AI, PDF, respectively) files, since they may 

contain both vector and raster data.  Images are exported in Joint Photographic Experts Group, Portable Network 

Graphics, and Tagged Image File Format (JPEG, PNG, TIFF/GeoTIFF, respectively) files, among others.  These are 

raster graphic file formats.  When exporting a map, the dpi request will be the one you set for your output file.  Thus, 

output image quality, file size, and processing time should be considered when choosing a file format in which to export 

your map.  The ArcGIS Resource Center provides further guidance on the many types of file formats and settings to use 

when exporting a map.   

 

VI.  WORKING WITH FEMA’S NATIONAL FLOOD HAZARD LAYER  

      (A DEMONSTRATION) 

In this demonstration, we will be assembling all of the steps we’ve learned so far in order to use services in two ways:      

1) through an OGC web mapping service and 2) through ArcGIS Online.   Let’s assume we are an engineer contracted to 

design office space as part of an expansion project.  We’ll need to determine first, whether our building will be located 

within the floodplain of the nearby river. 

 

Web Map Services (OGC WMS) for the NFHL 

In order to access the web mapping service through ESRI’s ArcGIS interface, we will need to display National Flood 

Hazard Layer (NFHL) data in ArcMap through FEMA’s Web Map Service (WMS).  The WMS can be accessed through 

FEMA’s online Map Service Center at https://hazards.fema.gov/femaportal/wps/portal/NFHLWMS  or you can search 

using your browser and the proper key words.  A portion of this page corresponding to the above link is provided below.   
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If you were to scroll down this web page, you would see all of the GIS services made available in which to access NFHL 

data.  However, for this demonstration we will be using the OGC compliant web mapping service.  To access layer 

information, we will scroll down this page until we are provided with the OGC WMS URL address to be used in ArcMap as 

shown below.   

 

 

Also note the URL address to the Capabilities file is provided.  This file provides information about the service and 

sublayers, including limitations, as discussed earlier about working with WMS service layers.   
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1. Open ArcMap and connect to the WMS server.  In the 

Catalog window, expand the GIS Servers node and 

double-click Add WMS Server.  The Add WMS Server 

dialog box appears.  Enter the server URL.  Click the Get 

Layers button to initiate a connection.  Notice that 

information from the WMS Capabilities file is also 

included beside the sublayers shown here.  You do not 

need an account for this service.  Click OK to close the 

dialog box.   

 

2. Add the GIS service for use in ArcMap.  To minimize 

requests to the server, we will add the entire WMS 

service (all layers) into the table of contents, then go to 

the Layers tab of the Properties dialog box to turn the 

display on and off for individual WMS sublayers.  Click 

the Add Data button  on the Standard toolbar to open 

the Add Data dialog box.  Once connected, you should be 

able to select the National Flood Hazard Layer and add it 

to your map.  The resulting table of contents from within 

ArcMap is shown below.  
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If you expand the WMS service layer and then the WMS group layer (“Layers”) 

to see the sublayers, notice initially how only the “NFHL Availability” sublayer 

appears visible.  You would need to adjust your view to a larger scale to see 

more sublayers.  (In this case, you may also have to first zoom to Full Extent and 

then draw a box with the Zoom In tool in order to locate and somewhat center 

the image in your ArcMap document.)  If you expand the sublayers, as we have 

with “High Water Marks”, you will see symbology.  Notice only certain layers are 

turned on for viewing.  This was set by the WMS server, but can be adjusted by 

the user as follows:  

  

3. Working with the WMS service layers in ArcMap.  Right-click on the WMS service 

layer and select Properties…  Select the Layers tab.   
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Then select the sublayers for which you would like to view or inquire, by turning on only those of interest.  Select the radio 

button for Just the layers listed below:  and click the single arrow button with the check mark to add the visible layers.  

We will choose the following limited sublayers, but leave the drawing order as is.  Click Apply to update your table of 

contents and/or OK to apply the changes and close the dialog box.   
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4. Navigate to your area of interest.  In this case, we have added the Streets base map from the Add Data, Add 

Base maps… command discussed earlier to help us get there.  It may be helpful to turn off the NFHL while 

navigating to your area of interest in order to minimize requests made to the WMS server which will slow 

performance.  In this demonstration, we will navigate to downtown Jacksonville, Florida near where Hogan Creek 

enters the Saint Johns River.  

 

5. Adjust your display settings for optimum viewing and analysis.  From the website where we received the URL to 

connect to the web map service, we know that some of the NFHL spatial layers are only visible at certain scale 

ranges.  In particular, detailed flood maps are only available when zoomed in past a 1:50,000 scale.  We will set 

our viewing scale at 1:10,000.  At this scale, you may wish to display certain layers over others or expand the 

sublayers to note their symbology.   

 

It is worth mentioning that since the WMS service layer was the first layer added to our ArcMap document, the coordinate 

system of the data frame became that of the WMS service layer.  The author of this service does provide the option to 

change to another coordinate system.  This can be done by simply right-clicking on any of the layer or sublayers and 

selecting the Change Coordinate System… command.  For this demonstration, we will leave the coordinate system as 

was originally published. 

 

6. View and query the data.  Now that we have our location within view and are at a scale where we can also view the 

desired sublayers, we are ready to query the features.  With just the mapped sublayers, we can already determine 

whether or not our area of interest lies within a flood hazard zone, and the base flood elevation at that location. 

Using the Identify  tool, we can select any location on the map closest to our desired point or area of interest, 
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and the Identify dialog box will appear and calculate the number of 

features selected for inquiry from each of the underlying sublayers.  

Make sure that you are identifying features from  <Visible layers>  for 

reasons discussed earlier in the section subtitled, Querying features 

from a WMS layer.  This WMS allows a limited number of WMS Features 

to be queried at one time.  We will select the Letter of Map Amendment 

(LOMA) here as our point of interest (Lavender colored dot).   The fields 

provide reference information for how the floodplain map was amended 

in this location, as well as the effective date of amendment.   This 

information may prove useful for your engineering model if you are 

performing a floodplain analysis for a permit.  If we were to query the 

Flood Hazard Zones WMS Feature, the fields would let us know the 

Digital Flood Insurance Rate Map (DFIRM) number, whether the 

selected point is located in a Special Flood Hazard Area (SFHA), and 

the type of Flood Zone.  In this case, we were not found to be in a SFHA, 

meaning our point of inquiry would not be covered by floodwaters from 

the base flood.  In other words, flood insurance is not necessary for the 

location of concern.  The aqua and orange colored zones represent 

SFHAs with increasing hazard potential, respectively.  In addition, we 

are at a scale where cross-sections and their base flood (100-year) 

elevations come into view.  The author published this information using 

labels.  The resulting table of contents, map and results from our inquiry 

can be seen here and below.  
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Enlarged view 

of Identify box 
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You may not be able to expand certain sublayers to view their symbology.  In the case of Flood Hazard Zones, you will 

have to add the legend to the map in order to decipher the shaded and hatched areas.  To do this, simply right-click on 

the sublayer and select Add WMS Legend to Map.  (It is a graphic, and can be deleted.)  Optionally and as discussed 

earlier in the subsection entitled, Changing the display of a WMS layer, you can right-click on the sublayer to determine its 

layer properties.  Select the Styles tab to view the legend symbology.   

So by displaying and querying the WMS inside ArcMap, we can gather intelligence for our project, or use the data in 

conjunction with other services or layers.   

If we were to export this map for inclusion in a report, at 300 dpi and with adaptive image compression (the default), a 

PDF document would result in about a 2 MB file size.   

 

The NFHL through ArcGIS Online  

The NFHL GIS service is also available through an ArcGIS Online portal called the FEMA GeoPlatform that allows users 

without an ArcGIS license to view and query flood hazard data much like with the WMS.   It is a simple viewer that 

requires only a web browser to use.  Below is how our area of concern in Jacksonville would look at similar scale inside 

the viewer: 
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The same layers are provided as in our WMS, and we have added the same Streets base map.  If we were to click on the 

Legend option shown above the table of contents, each layer would be listed with the same symbology as that of the 

WMS.  Again, we will query the effective LOMA point as indicated here.  To do this in the viewer, simply left-click on the 

point.  The box appears as shown above with the same information as found in the Identify dialog box in ArcMap.   

 

We can also expand the individual sublayers in the table of contents to open a table for all or selected attributes of the 

map features.  These tables share similar query functions as those in ArcMap.   

 
FEMA also offers information related to the NFHL through the OGC Web Feature Service (WFS).  So if it was determined 

that our building was indeed located within the FEMA regulated floodplain, we may wish to use the WFS to access cross-

section data needed for an engineering analysis.   This analysis determines whether the additional cut and fill operations 

resulting from our designs, as well as the additional building square footage, will alter the floodplain of the nearby river.  

Remember, features streamed through a GIS web service may be limited.  In this case, requests from the NFHL WFS are 

limited to 1,000 features.   

While we changed the base map used in this online map viewer for visual clarity and 
comparison purposes, the advantage of using this viewer over the WMS in ArcMap is that 
the default base map is from a USGS service and conforms to FEMA's specification for 
horizontal accuracy.  While in ArcMap you have the flexibility to display just about any 

image as your base map, you should always ensure the map meets FEMA’s standards for 
map accuracy if you plan to use it for official purposes. 
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VII.  CREATING AND SHARING PACKAGES 
 

Exporting your map to a graphics file is just one way to share your work. As we have seen, 

ArcGIS provides ways that allow one to benefit from server and online technologies to share 

a map and, in some cases, the geographic data behind it.  We have already learned how to 

access and manipulate multiple web-based services and packaged data prepared by 

others.  The rest of this course will be dealing with the most exciting tasks – creating our 

own packages and services to share with others. 

 

The release of ArcGIS 10.0 and subsequent versions have led to the development of 

various ways to package data for delivery and sharing with others at all license levels.         

As with GIS services, we will limit our discussion to Layer Packages and Map Packages.  

They can be shared via e-mail, disk, file share server, or through ArcGIS Online.  ArcGIS 

Online allows you to publish GIS web services to an ESRI-administered Cloud environment.  

You must subscribe and sign into an ArcGIS Online account, but there is no software to 

install and maintain.  Two common ways for packaging and sharing your data and maps are 

discussed below.  

  

 

 

 

 

 

Considerations on sharing 
data through web services 
 
GIS web services provide a whole 

new way to collaborate on 

projects amongst team members 

or to communicate with 

stakeholders.  Design-Build 

projects are good examples of 

where web services allow for 

consultants or contractors 

working under Joint Venture 

agreements to work closely 

together while limiting access to 

companys’ proprietary 

information.   

 

If you are considering using third-

party published data, always 

review the metadata and verify its 

accuracy, especially when relying 

upon for engineering analyses or 

designs.   
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Layer Packages (*.lpk files) 
 

Layer packages and map packages were introduced in Section IV.   

The steps below show how to create a Layer Package. 

 

 

 

1. From within ArcMap, select the layers you want to package.  In the 

graphic, the “USGS NHD” layer was downloaded from a geospatial 

gateway, and the Bing Maps Road is an ArcMap built-in base map.  

Right-click on a selected file(s), and choose Create Layer Package… 

from the context menu. 
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2. Once the Create Layer Package dialog box opens, name your layer package and 

specify where to save it – either as a file on disk or in your ArcGIS Online account 

for sharing with others.   

 

 
 

3. You can choose to include data from an ArcSDE geodatabase (see Glossary) or to 

include an empty geodatabase with your layer package.  Including an empty 

database means that you are only including the schema, or design, of your 

ArcGIS 10.2.x Users 
 
Complimentary use of Bing Maps 

is being phased out for ESRI 

products.  Starting with ArcGIS 

10.2, you will need to obtain a 

license key directly from Microsoft 

to use any of the base maps in 

the Bing Maps collection.  We are 

still referencing it here due to the 

presumption that Bing Maps are 

still available for the majority of 

users.   

 

A recommended replacement for 

10.2 users is the ArcGIS World 

Imagery base map.  It provides 

worldwide satellite and aerial 

imagery at one meter or better in 

resolution.   

 

http://www.suncam.com/


 
GIS – Beyond the Basics:  Web Maps & File Sharing Services 

A SunCam online continuing education course 

 

 
www.SunCam.com  Copyright 2015 Julie Coco Page 56 of 78 

 

database and not the data itself.  With the Package schema only option, the end-user will be prompted to create 

the new datasets for the layer(s) in a geodatabase once the layer is unpacked.   

 

4. Enter documentation about your map in the ArcMap document by clicking File > Map Document Properties and 

entering the map title, description, author, and tags in the dialog window that opens.  Some of this information is 

mandatory for creating a layer package.  Make sure the check box for Store relative pathnames to data sources 

is checked. 

 

5. Validate the composition of your package.  (Users of ArcGIS 10.2.x will select the Analyze button to find any errors 

or warnings.)  Running this procedure will analyze the layer(s) for any errors or issues.  If any are encountered, a 

Prepare window will appear with a list of the errors or issues such as the one below.  Right-click each message to 

see a list of options for resolving any errors or issues.   

 

 
 

6. Once validated, the Share button will be enabled.  Click this button to create your layer package.   
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Map Packages (*.mpk files)  
 

Sharing a map package has the potential to make it easier for recipients of your map to understand your data without 

being fluent ArcGIS users.  Map packages can be created through the ArcMap interface or through the use of 

geoprocessing tools in the Package toolset of ArcToolbox.  Generating a map package with ArcGIS 10.x is easy and 

straightforward.  However, the map and its data must be carefully prepared so they will be meaningful to others, and such 

that can be readily used by them.  Below are some good practices to assist you in preparing a Map Package: 

 

 Simplify and minimize the data required for the map.  Clip any dataset that is larger than what the map needs to the 

extent of the area of interest.  For each layer that will be shared with the map, open its Layer Properties dialog box 

and turn off any unnecessary fields in the attribute table.  Always create meaningful field aliases for the fields that 

will be displayed.   

 

 Specify a useful primary field to be used in Map Tips, the Identify dialog box and/or the Attributes window.  

Alternatively, with ArcGIS 10, you can create a display expression.  A display expression is a custom string that 

can include values from multiple fields in the same way that label expressions can be created.  To create an 

expression, click the Display tab on the Layer Properties or Table Properties dialog box, and click the Expression 

button.   

 

 Symbolize layers to emphasize attributes or classes of features deemed important.  Specify appropriate display 

units and units for the X, Y readout on the status bar.  Make the map easier to use by turning on Map Tips and 

HTML pop-ups for key layers.  Create bookmarks for useful map extents.   
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Once a user-friendly map has been prepared, you are ready to package your map and data.  The steps below show how 

to create a Map Package using the ArcMap interface. 

1. Click File > Create Map Package, or File > Share As > Map Package…, depending upon your version, from the 

main menu.   

 

2. Once the Map Package dialog box opens, name your layer package and specify where to save it – either as a file 

on disk or in your ArcGIS Online account for sharing.   

 

 
 

3. As with Layer Packages, you can choose to include data from an ArcSDE geodatabase. 
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4. Enter documentation about your map in the ArcMap document by 

clicking File > Map Document Properties and entering the map title, 

description, author, and tags in the dialog window that opens.  Some of 

this information is mandatory for creating a map package.  Thus, you 

can opt to do this as Step 1.  Make sure the check box for Store 

relative pathnames to data sources is checked.   

 

5. As with Layer Packages, validate the composition of your map 

package from the Create Map Package dialog box.  Running this 

procedure will analyze the layer(s) for any errors or issues.  (Users of 

ArcGIS 10.2.x will select the Analyze button to find any errors or 

warnings.)  If any are encountered, a Prepare window will appear with a 

list of the errors or issues.  Right-click each message to see a list of 

options for resolving any errors or issues.   

 

6. Once validated, the Share button will be enabled.  Click this button 

to create your map package.  You may have to save your map 

document.  Upon completion, a message box confirms the destination 

of your *.mpk file.   
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If you are uploading layer packages or map packages to 

ArcGIS Online:  

 

7. Sign into www.arcgis.com using your account when 

prompted. 

 

8. Once the ArcGIS Online Package Details dialog box 

appears, complete the fields specifying if you are sharing 

your map package with everyone or with specific groups.  

(Users of ArcGIS 10.2.x will have sharing options while still in 

the Map Package dialog box and prior to clicking on the 

Share button.)  Click OK.   

 

 

 

Note:  Packages uploaded to ArcGIS Online cannot be 

added to ArcGIS Online web maps.  They are for use strictly 

within ArcGIS for Desktop.  To make map packages 

available for web mapping applications, you will need to 

publish your data as map services using ArcGIS for Server.   
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About Packaging Data 

The packaging process involves editing and preparing different types of data.  Below are some additional points to 

remember when packaging data: 

 Whether it’s a layer file (*.lyr) or a layer package (*.lpk), consider the paths you will need to reference the data.  

The default is to store absolute path names.  This can be changed through your map document properties (File > 

Map Document Properties).  You may wish to save layers and packages with relative path names to enable them 

to be moved to any disk drive without having to repair broken links.   

 Because ArcGIS 10.x works with file geodatabases, layers referencing data in personal geodatabases will be 

converted.  (Personal geodatabases are not supported in ArcGIS 10.1 for Server or later releases.) 

 

 Raster data can be included in packages.  Uncompressed rasters will be clipped based on the extent specified in 

the Data Frame properties.  Compressed rasters will not be clipped, even if an extent has been specified.  

Likewise, images in maps added as either data, or graphics on the page layout, will always be included in map 

packages unless they exist in an ArcSDE database.  By default, data in an ArcSDE database will be referenced, 

requiring users to have access to that database.  However as discussed above, you can include your data in the 

package by checking the Include ArcSDE geodatabase data check box when using the Package tool.   

 

 Datasets that reference other datasets, such as table joins, relationship classes, topology, geometric networks, or 

locators, will automatically be consolidated into a map package.   
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VII.  PUBLISHING SERVICES THROUGH ARCGIS ONLINE 

  
You should have a purpose in mind as to how you want to publish your service.  Is the service primarily for ArcGIS users, 

or does it need to be made available through an open, internationally recognized standard?  To whom are you sharing this 

data?  Does the map service need to be published for mobile devices?  We have primarily discussed ESRI products; thus 

you already know that you can publish services to ArcGIS for Server.  In order to publish services like those discussed, 

you will need to install the server software on your machine when installing ArcGIS for Desktop.   An installation of ArcGIS 

for Server software is called an ArcGIS Server site.  The server software is offered at the same license levels as ArcGIS 

for Desktop.  That is, ArcGIS for Server is available in Basic, Standard, and Advanced editions.  Once you have created a 

service in ArcMap, you can then publish it to this server using a publishing wizard or a toolbar.  A login account is 

required, and with it, you can access an ArcGIS Server site as an Administrator, Publisher or User, depending upon 

privileges configured by the administrator.       

 
Optionally, you can register your web service with ArcGIS Online so it can be easily discovered and used by others.          

A login account is required for publishing to ArcGIS Online; however, unlike ArcGIS for Server, this option requires no 

separate installation or maintenance; it comes with your ArcGIS for Desktop purchase.  Users can create groups and 

invite others to work together on projects of common interest.  Through an organizational subscription, a company or 

group can have their own secure URL address for publishing and sharing maps and data. Groups can be either private 

(with subscription) or public, and members can share maps, data, and other content with each other efficiently.  ESRI 

hosts and administers GIS web services in this Cloud environment.  ArcGIS Online allows for different subscription plans 

based upon the number of users.  Service credits are provided for using services such as geocoding, hosted feature or tile 

services, or spatial analyses in this environment.  Whether it is an on-premises solution or part of a Cloud solution, the 

server and capabilities are the same.   
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For newcomers to web services, we will illustrate how to publish services through ArcGIS Online.  The process is similar 

to publishing with ArcGIS for Server software, yet requires less setup.     

 

Before publishing a map service, you may wish to further ask yourself:  1) “Am I publishing a map service with cached or 

dynamic maps?”  2) “Do I want my map service to serve features?”  Remember, authoring a web map service requires 

starting with a base map that you’ve created.  In addition to the layers you may have added, you will set viewing extents 

and other parameters, as well as add a description of the map before publishing.   

 

Before publishing an image service, you may wish to ask yourself the following questions:  1) “Is my raster for viewing as 

an image or will the data be used as input for analyses?”  2) “Is there one raster dataset or many raster datasets?”  3) 

“Will users be downloading imagery from or uploading to this image service?”  The answers to these questions determine 

the properties and capabilities you make available when publishing the service, and are dependent upon your 

organization’s choice of server.   Detailed, online help and requirements for preparing map and image services are 

available from ESRI’s ArcGIS Resource Center.  

 

Preparing and Sharing Data Online   

Let’s assume you’ve created a map inside ArcMap and are ready to publish it as a service.  The steps below illustrate how 

to prepare your data for publishing through ArcGIS Online: 

 

If you will be needing to share more advanced services, such as image services,  
geoprocessing tools, or need higher security options for your work, you should talk with 

your organization’s IT Professional or GIS Manager for installation of GIS Server software. 
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1. From the main menu, select File > Sign In…   

Login to ArcGIS Online through your organizational 

subscription.  (Note that if you login from the main 

menu by selecting File > Sign In… , you will only 

see maps and data for your organizational 

account.)   

 

 

 

2. From the main menu, select File > Share As > 

Service… 

 

3. When the Share As Service wizard appears, 

choose Publish a service.   

 

 

 

 

 

 

You can access both ArcGIS Online and ArcGIS Resources with a free 
ESRI global account.  Access via the former is limited to a public account, 

but does not require the purchase of ArcGIS for Desktop software. 
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4. Next, choose a connection to the server.  Your ArcGIS Online organizational subscription account will be listed as a 

hosted service both here, and in the Catalog window.  When you login, your account name will be shown in 

parentheses.  (You may also connect to an ArcGIS Server by selecting the icon to the right.)  The Service name 

will default to the name of your open ArcMap document.  When finished, hit Continue. 
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5. The Service editor appears, 

and another window opens 

in the background with 

messages pertaining to 

publishing.  From here, you 

will start by setting the 

parameters you want for 

your map service.  Thus, if 

applicable and desired, you 

can choose anti-aliasing of 

your text and vector features. 

Anti-aliasing is a technique 

used to trick your eye into 

seeing smoother edges of 

features by blending pixels.  

Think of it as increasing the 

resolution of your computer 

monitor.  A higher degree of 

anti-aliasing increases the 

visual appeal of your map, 

but comes at the expense of 

the drawing performance of 

your service.   
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6. Choose the capabilities you want for your map service.  With ArcGIS Online, there are two types of capabilities you 

can allow.  Feature service capabilities allow a user access to the geometry, attribute and symbol information for 

vector features.  Thus, editing business data is allowed in addition to querying it.  Tile map service capabilities 

allow for caching map images, as defined earlier, to allow for viewing as basemaps in a web mapping application.  

Notice in the left column of the Service Editor dialog box below that only tiled mapping was selected this time. 

 

7. Choose your tiling scheme.  A cached map service can support multi-scale maps. It does this by creating image 

tiles for your map at a specified series of map scales. You choose the map scales at which your feature cache will 

be computed at say, map scales of 1:100,000, 1:60,000, 1:30,000, 1:10,000, and 1:5,000.  Frequently, users will 

choose to use a standard cache tiling scheme such as the Web Mercator cache schema used in Google Maps, 

Bing Maps, and at ArcGIS Online.  This is what has been chosen here.  You can also use an existing tile scheme 

file (.xml), or have the wizard suggest one for you.   
 

 

You should find a balance of minimum and maximum scales along with a number of levels to achieve a reasonable cache 

size for your map.  In this illustration, three feature layers comprised of county boundaries, municipal boundaries, and 

roadways were grouped to form a basemap for the state.  For the purposes of this map, our viewing scale will typically be 

anywhere from the county level (as construction plans typically require the name of the county/parish in which the project 

resides) down to the project site level.  Therefore, our minimum caching scale was set at the county level.  The maximum 

scale was set at the city block level, and generates a reasonable cache size for desktop applications.  Mobile devices may 

require less cache.  Advanced settings allow you more control over the scale range, tile image format, and even individual 

tile size.   
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8. Provide information about 

your map service.  This is 

the metadata for your 

service.  A summary and 

descriptive tags are 

required.   
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9. In the Sharing dialog window, decide how you want to share your service.   

 My Content – References the service in your personal workspace named “My Content”.  It is inaccessible to other 

users. 

 Your Organization’s Name – Allows your work to be accessible through your ArcGIS Online subscription account, 

whereby you decide how it should be shared throughout your organization.   

 Everyone (public) - Selecting this option makes your service public. This means anybody can access and see 

your service, including users on the web. 
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10. The next step is to analyze your map service for publishing errors or performance drags.  This is where your 

cartography skills come into play.  Once you select the Analyze button from atop the Service Editor dialog box, you 

will see another window displayed within ArcMap, similar to the one below.   

 

 
 

 

This is a list of layers with problems.  You should correct the errors and most warnings before proceeding.  These 

messages pertain to publishing rules and suggestions for improving service performance.  Right-clicking the status of a 

layer will provide access to help, and suggest immediate tasks for making adjustments to your map.  In some cases, you 

are allowed to override the warning or message through an Exception.  You may be allowed to make an exception for 

errors; however, this usually means the server will adjust the problem for you, potentially resulting in the unexpected.  

Solutions to common errors, as well as publishing tips, are discussed at the end of this section.  

 

11. Once you’ve addressed the problems, you are ready to preview your service.   Ensure that all layers are turned on, 

then select the Preview button from the Service Editor dialog box to view the map.   
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Preview window of a map service inside ArcMap 

 

You can select the button in the top, right corner of the preview window to zoom or pan to the map location in order to see 

how your service compares with your original map, as well as how it will look to others.  Notice the difference in effect 

from anti-aliasing between the service preview, and that created in the ArcMap document.   
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12. If all looks good, then close the preview window and select the Publish button.  From here, your internet service 

provider takes over, and starts publishing.  Your information is copied to ESRI’s ArcGIS for Server (at 

www.arcgis.com) for access to those you specified.  It is highly recommended that you keep a copy of your original 

ArcMap document used to publish the service for future editing and maintenance. 

 

When your service is published, your map is packaged for delivery to ArcGIS for Server used with your ArcGIS Online 

account.  A service definition file (*.sd) is created as part of the packaging process based on the parameters and 

capabilities set in the steps just described.  Alternatively, you can import such an existing file.  This option is executed 

through the Import button shown in the Service Editor dialog box.        

 

Once publishing is complete, you should be able to view the map service item in the Catalog window under your list of 

hosted services.  Right-clicking on the item allows you to view the cache generated while building tiles (if applicable), and 

manage other properties.  If you had selected the option to publish to ArcGIS Online, then when you login to your account, 

you should see your service listed as a Tile Layer along with the service definition file.  Both are listed in your “Gallery” or 

under “My Content”.  From here, users have the option to add your service as a layer in their own online map or to open it 

in ArcGIS for Desktop.  Below is a screenshot of how the map service and table of contents appear inside ArcMap.   
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A web map service as viewed within ArcMap 

 

 

http://www.suncam.com/


 
GIS – Beyond the Basics:  Web Maps & File Sharing Services 

A SunCam online continuing education course 

 

 
www.SunCam.com  Copyright 2015 Julie Coco Page 74 of 78 

 

About Publishing Services 

Below are some points to remember when publishing a service: 

 Unused layers and data frames should be removed.  This includes those in both the data view and page layout 

view.   

 

 Set reasonable viewing scale ranges, or clip only the data you need for your service.  For instance, if you include a 

layer in your map that has nationwide data, but the work for which your map service was designed will always be at 

the state level, then server requests will be prolonged for each re-generation of the map view by users of the 

service, especially when using dynamic maps or when outside of your map’s cache range.  If the layers draw at all 

scales, all of the nationwide data will be re-drawn with panning, zooming, etc., whether users need this data or not.   

 

 Simplify layer symbology by avoiding complicated dash patterns, outlines or symbols, such as highway shields.   

 

 Annotation should be used in place of labels.  Since labels require placement decisions, annotations can be 

generated much faster.  If you must use labels, consider scale-dependent rendering.   

 

 Feature class layers should have a spatial index.  A spatial index is used to locate features quickly when you 

display, query or edit data.  The command for creating an index will be available when you are analyzing your 

service and prompted with the warning.   

 

 Ensure the same coordinate system is being used for both your data and map.  Any data that has to be projected 

“on the fly” for your map will affect map performance.  Additionally, your coordinate system should match that of 

your schema for caching tiles, as they are set independently of one another.  If you are using the schema used by 

Google Maps/Bing Maps/ArcGIS Online for example, your data frame’s coordinate system will be changed to the 
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WGS 1984 Web Mercator coordinate system in order to cache image tiles, if it is not the same.  You will be 

prompted to correct this when analyzing your service before publishing, as shown in the Prepare window above.   

 

 Referenced basemap layers, or embedded map services, cannot be published as a service.   

 

These are a few of the more common and easy to correct errors, warnings, and messages you might receive when 

analyzing your service for performance.   

 

 

IX. CONCLUSION 

 
This course covered the most common packages as well as map and image geoservices.  Other packages than can be 

shared include tile, locator and geoprocessing packages.  Other services that can be published include geocoding, 

network analysis, mobile data services, and OGC Web Map Tile Services (WMTS); the list continues.  Packages are 

available at all license levels.  Publishing capabilities are enabled according to the subscription or license level purchased.  

Whether you are a professional user of GIS products, or only a recipient of the end-result, more people can access 

information more efficiently with online maps.  In fact, as of this writing, ESRI has made elevation, hydrology, and 

viewshed geoprocessing tools available through their ArcGIS Online hosted analysis services.  These tools are made 

available to professionals such as hydrologists, engineers, and security analysts without the need for retrieval, storage or 

maintenance of terabytes of data on local machines.  Web maps are shared through internet and mobile device 

applications, through links, or embedded in websites allowing engineers, developers, project managers and others to 

collaborate, and yet control their data, like never before.   
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GLOSSARY 
As GIS technologies evolve, others are being replaced or retired.  As such, some terms are new, while others are often updated to 

distinguish the new technology or to improve semantics.  Hence, it is important to provide a glossary for this course. 

 

ArcGIS for Desktop – formerly ArcGIS Desktop.  ESRI product that allows PC users to view, query, analyze, process, share and 

author spatial data.  It includes the ArcMap application, and is available in three license levels:  Basic, Standard and Advanced.   

 

ArcGIS for Desktop Basic – formerly ArcView.  License level for PCs that allows for map and data display and interaction, the 

publishing and sharing of maps and data, CAD support, map labeling and annotation, automation of work flows, and management of 

metadata.       

 

ArcGIS for Desktop Standard – formerly ArcEditor.  License level for PCs that includes those capabilities of the Basic version plus 

advanced cartographic editing tools such as mosaic dataset creation.  Also includes capabilities such as multi-user geodatabase 

editing, geodatabase topology rule creation, and web editing support for ArcGIS for Server Feature Services, to name a few.  

 

ArcGIS for Desktop Advanced – formerly ArcInfo.  License level for PCs that includes those capabilities of the Standard version 

plus capabilities such as additional geoprocessing of features, advanced spatial core analysis tools, creation of publication-quality 

maps with high-end cartographic tools, and legacy ArcInfo Coverage data geoprocessing.    

 

ArcGIS Online – A cloud-based collaborative content management system for maps, applications (“apps”), and data.  Delivers 

online GIS capabilities that you can access over the Web, plus useful maps and data published and hosted by ESRI and partners 

that you, as well as others, can use in Web GIS applications.  The ArcGIS.com map viewer was built for web applications.       

ArcGIS Online is included with an ArcGIS for Desktop license, and allows access to the same services for all Desktop license levels.  

www.arcgis.com.    

ArcGIS Resource Center - A Web-based portal that provides access to online help, community pages, blog posts, support 

information, and templates to help you get started applying ArcGIS.  From the Resource Center, one can get connected with others 
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in their user community.  From the home page, one can sign in using a (free) ESRI global account or login to ArcGIS Online with their 

subscription account.  http://resources.arcgis.com 

ArcGIS for Server – formerly ArcGIS Server.  A server for use in publishing GIS services online to various clients.  For instance, 

ArcGIS for Server is used to publish WMS and ArcGIS Online services (i.e., to share GIS capabilities).  It also supports workgroup 

and enterprise data management.  Services include both maps and images (raster and mosaic datasets).  It is ESRI’s replacement 

for ArcIMS, the classic web server.     

ArcGIS for Server image services – Raster datasets served from the ArcGIS for Server as web-based image services.   Image 

services published through this server may be enabled with Image Service, WCS, or WMS capabilities.  Images published with 

ArcGIS Image Service capabilities possess mapping capabilities similar to that of a map service.  

ArcGIS for Server map services – Map documents created from within ArcMap and served from the ArcGIS for Server as web-

based map services.  Map services published through this server may be enabled with the OGC WMS specification.  Map services 

can be used as layers in ArcMap (or ArcGlobe).  Additionally, you can use ArcCatalog to preview and administer a map service. 

ArcIMS – ESRI’s Internet Map Server.  ArcGIS 10.0 was the last release of ArcIMS.  With the adoption of ArcGIS for Server and the 

move to 64-bit servers, ArcIMS is no longer the recommended product for producing web maps. 

ArcSDE Database – SDE stands for Spatial Database Engine. It is ESRI’s technology for accessing and maintaining geospatial data 

within relational database management systems (RDBMS).  In other words, it is a multi-user geodatabase capable of handling large 

volumes of data, and which is interoperable with other database management systems, such as Oracle, SQL Server, etc.  The 

ArcSDE geodatabase is integrated with both the ArcGIS for Server and ArcGIS for Desktop products.   

 

Client – Web, mobile, and desktop applications that connect to servers such as ArcGIS for Server internet or local services.  ArcGIS 

for Desktop is an example of a client that either uses GIS services or prepares information, such as maps, for publishing to a GIS 

server.  ArcGIS for Desktop (ArcMap/ArcGlobe/ArcReader), ArcGIS Online (the ArcGIS.com map viewer), and ArcGIS Explorer 

Online are all client applications.  Non-ESRI web applications include:  Google Earth, AutoCAD, and the OGC WMS/WCS/WFS client 

applications.   
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GIS (Web) services or Geoservices – Web-based GIS services in which users create geographic elements such as maps, 

geodatabases, geoprocessing tools and models, and mosaicked images.  These elements provide automated GIS services that are 

published and accessed over the Web using standard technologies and protocols.  Types of GIS services include:  map services or 

WMS, image services, geocode services, geoprocessing services, and search services. 

Mosaic Dataset – Multiple raster datasets within a geodatabase that allow one to manage and serve large collections of raster and 

image data.  They are created with ArcGIS Standard or ArcGIS Advanced licenses, and served using an ArcGIS for Server Image 

Extension.  (Mosaic datasets replaced the image service definition files (.ISDef) used to create image datasets with the old ArcGIS 

Image Server.)   

Open Geospatial Consortium, Web Coverage Service (OGC WCS) – An interface standard or specification developed by the 

Open Geospatial Consortium for requesting and sharing coverages on the Web.  Coverages represent digital geospatial data with 

space-time varying phenomena.  The WCS is used to serve coverages as raster images (satellite images, digital aerial photos, digita l 

elevation data, etc.) with multi-dimensional properties.  Cell values from rasters published with this specification are raw data values.  

This service allows access to geographic data (as well as maps) for editing and spatial analyses, and is an extension of the WMS 

interface.   

Open Geospatial Consortium, Web Feature Service (OGC WFS) – A specification developed by the OGC for requesting and 

sharing geographical feature data on the web.  This service allows access to geographic data for editing and spatial analyses.       

The basic WFS allows for querying and retrieval of features.  

Open Geospatial Consortium, Web Map Service (OGC WMS) – An interface standard or specification developed by the OGC for 

requesting and sharing dynamic maps on the web.  It is also defined as a standard protocol for serving georeferenced images over 

the internet that are generated by a map server using data from a GIS database.  WMS services are useful if you want to make your 

maps available to others in a recognizable way across different platforms and clients.  The maps returned by a WMS service are 

images only (PNG, GeoTIFF, etc.).  They do not contain actual data.     
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